
Using Internet Explorer 7 
Getting Started 
Thanks to Wellesley College for this wonderful document! 
 
To launch Internet Explorer 
 
On a Windows PC, double-click on the Internet Explorer icon on your desktop. You can 
also click on the Start menu and go to All Programs to select Internet Explorer. 
 

 
 
 
To turn on the Menu Bar 
Internet Explorer 7 does not display the Menu Bar by default.  

 
 

1. Right Click on the window  
 

 
    2. Make sure Menu Bar is checked 
 

 
 
 
 
 
 
 
 
 
 



 
Using Internet Explorer 7  
Overview 
 
    Below is a picture of the Internet Explorer window with important components 
highlighted. 
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    Note: If the Menu Bar (File, Edit, etc.) disappears completely, you can restore the 
menu bar by clicking on the Tools button and making sure that the Menu Bar is checked. 
 
    
URL 
The Internet Explorer 7 window displays a home page upon launch. The URL (Universal 
Resource Locator) is the address of the webpage being viewed. Each webpage has its 
own unique URL. Some URLs are case-sensitive and all have to be typed exactly, 
including spaces or special symbols such as ~. 
 
 
 
 
 



 
Navigate 

 
The Back button lets you return to the last webpage that you visited. If you click on the 
downward facing triangle to the right of the button, you can see a menu of webpages 
you have visited. 
 
Reload/Stop 

 
When displaying a webpage, IE transfers a copy of the webpage from the Internet onto 
your computer. Therefore if the webpage changes, you can update the webpage in your 
browser window by clicking the Reload button with the green arrows. If the webpage is 
taking too long to load, you can stop the process by clicking on the Stop button with the 
red X. Click on the Reload button to start the loading process again from the beginning. 
 
Home 

 
The Home button lets you return to the home page that you set. You can change the 
home page by going to Internet Properties. 
     
Search Engine / Search Provider Search 

 
You can type in a word or a phrase to search the Internet. Putting a phrase in quotes will 
search for that exact phrase. You can change the default search engine to Google or 
something else. 
  
Favorites 

 
In order to save the webpage URL link for future web browsing sessions, you must save 

it as a bookmark by clicking on the Add Favorites button . Clicking on the View 

Favorites button , allows you to see all your favorites you have saved. You can also 
export and import bookmarks. 
    
Tab Browsing Features 

    
The Tab Bar allows you to have multiple webpages open at once in a single window. 
Each webpage will appear under a separate tab and you can simply click on the tab to 
access that webpage. Read the tab browsing overview. 
 
Tabbed browsing overview 
 
• Tabbed browsing allows users to open multiple websites in one Internet Explorer 

window by clicking on the open New Tab button or pressing CTRL+T. 
 
 



• Users can preview thumbnail images of all open tabs in a single view (see 

screenshot below), by clicking on the Thumbnail View button       
 

 
 

• The Add Tab Group to Favorites feature allows users to save multiple tabbed 
windows into one favorite tab group. For example, a user may have ten tabs open 
and instead of saving each tab one-by-one, she can save them all at once into one 

group. Click on the  Add Favorites icon and select Add Tab Group to Favorites. 

  
 

Then next to Tab Group Name, type in a name (e.g. Disease Pathology websites visited 
Sept 1). Finally, click Add. 
 
 
Preferences 
To change your home page 
Your home page is displayed when Internet Explorer first opens or when you click the 

Home button . You can choose any webpage to be your home page. 
 
Option 1 
 
   1. Open Internet Explorer and go to the webpage you want to use as the home page. 

   2. Click the down arrow to the right of the Home button , and then click Add or   
Change home page. 
   3. In the Add or Change Home Page dialog box, click Use this webpage as your only 
home page. 
   4. Click Yes to save your changes. 
 
 
 



Option 2 
 
   1. Go to Tools and select Internet Options. 
   2. In the General tab, under the Home page category, type in the URL you wish to be 
your home page (e.g. http://www.bhasd.org). 
   3. Click Apply to save your changes. Click OK.  
 
To add a new search provider (search engine) 
 

   1. Click the down arrow to the right of the Search Options button . 
   2. Click Find More Providers.   
   3. Click the search provider you want to add. The Add Search Provider dialog box will 
appear. 
   4. If you want the provider that you just added to be used by default when searching 
from the Address bar or search box, select the “Make this my default search provider” 
check box. 
   5. Click Add Provider. 
 
To remove a search provider (search engine) 
 
   1. Open Internet Explorer. Click the down arrow to the right of the Search Options 

button . 
   2. Click Change Search Defaults.   
   3. Select the search provider you would like to remove. Click Remove and then click 
OK. 
 
 
To restore default settings in order to prevent IE7 crashes 
 
Occasionally Internet Explorer may become unstable and start constantly crashing. 
Before you consider uninstalling and reinstalling Internet Explorer, you can try returning 
IE7 to its default settings. 
 
   1. In Internet Explorer 7, go to Tools > Internet Options. Click the Advanced tab. (If 
your IE7 browser won't even open without crashing, you can also right-click on your IE7 
desktop icon and select Properties and then click the Advanced tab.) 
   2. Click the Reset... button near the bottom.  
 

 
 

A window will appear explaining to you what restoring your settings will do to your 
browser. For example, your favorite bookmarks will not be erased. Your add-ons will be 
disabled and your temporary internet files and cookies will get erased. Most users will 
not notice these items are gone or can easily re-enable them later. So if your browser is 
unstable, we recommend that you reset your browser settings. 



   3. Click Reset. 
   4. You will be prompted to close and reopen your browser. 
 
To empty the Temporary Internet Files folder (cache) 
 
Every time you visit a webpage, Internet Explorer saves a copy of the webpage to a 
folder called Temporary Internet Files. If this folder gets too full, Internet Explorer may 
run more slowly and behave in an unstable way. Also, if a webpage is not loading 
correctly and shows an error message (such as "Range not satisfiable..."), a common 
solution is to empty the cache. You should clear the cache at least once a month. 
 
   1. In Internet Explorer, click the Tools button, and then click Internet Options. 
   2. In the General tab, under Browsing history, click Delete. 
   3. In the Temporary Internet Files category, click Delete files, and then click Yes. 
   4. Click Close, and then click OK. 
 
To clear the browsing history 
 
The browsing history is a listing of all the recent websites you have visited within a set 
period of time (e.g. two weeks). Clearing your history list does not affect your 
bookmarks. 
 
   1. In Internet Explorer, click the Tools button, and then click Internet Options. 
   2. On the General tab, under Browsing history, click Delete. 
   3. In the History category, click Delete history , and then click Yes. 
   4. Click Close, and then click OK. 
 
To save a picture from a webpage 
 
   1. In Internet Explorer, using the mouse, right-click the picture you want to save. 
   2. Click Save Picture As. 
   3. In the Save Picture dialog box, browse to the folder where you want to save the file, 
and then click Save. 
 
To save a webpage onto your computer 
 
   1. In Internet Explorer, go to the webpage you want to save. Click the Page button 
Page button and then click Save As. 
   2. Navigate to the folder in which you want to save the webpage. 
   3. In the File name box, type a name for the webpage. 
   4. In the Save as type box, pick one of the following from the drop down menu: 
          * Webpage, complete: To save all of the files needed to display this webpage, 
including graphics, frames, and style sheets, select Webpage, complete. This option 
saves each file in its original format. 
          * Webpage, HTML only: To save just the current HTML webpage, click Webpage, 
HTML only. This option does not save individual files of images, sounds, or video onto 
your computer. But it does save all the HTML code information that would preserve 
formatting, text, hyperlinks, and the pathways to images, sounds, and video. 
          * Web Archive, single file: To save all of the information needed to display this 
webpage in a single file, click Web Archive, single file. This option saves a snapshot of 



the current webpage. This option is available only if you have installed Outlook Express 
5 or later. 
          * Text File: To save just the text from the current webpage, click Text File. This 
option saves the information on the webpage in text format. 
   5. Then click Save. 
 
To open the webpage that you have saved 
 
   1. Launch Internet Explorer 7. Then go to the File menu and select Open. 
   2. Click on Browse to find and select the file you want to open. 
   3. Click Open and then click OK. 
 
To make webpages load without images or sounds 
 
Loading a webpage with no images or sounds can speed up the time that it takes the 
webpage to load. 
 
   1. In Internet Explorer, click the Tools button, and then click Internet Options. 
   2. Click the Advanced tab. 
   3. In the Settings section, under Multimedia, uncheck the boxes next to Play sounds in 
webpages and Show pictures. Click OK. 
 
Notes: To view one image without downloading the other images, right-click on the 
selected image and then click on Show Picture. 
 
Bookmarks 
 
Bookmarks provide a permanent and easy way to remember your favorite webpages. 
They are only deleted when you delete them, not when you quit Internet Explorer. 
 
To create bookmarks (favorites) 
 
   1. Go to the webpage you want to bookmark. 
   2. Click on the Add to Favorites icon Add favorites or go to the Favorites menu. 
   3. Then click on Add to Favorites. 
   4. Give the webpage a name (e.g. American Revolution Prints) or keep its original 
name. 
   5. Select the folder you would like the bookmark to reside in. 
   6. Click Add. 
 
To view and use bookmarks (favorites) 
 

   1. In Internet Explorer, click on the View Favorites button . (Another option is to click 
on the Favorites menu in the main toolbar.) 

 



   2. From that list, click on the bookmark of the webpage you want to see. 
 
To organize your bookmarks (favorites) 
 
Internet Explorer lets you arrange your bookmarks in folders and change the order in 
which they appear. You can also rename and delete your bookmarks. 
 
   1. In Internet Explorer, click on the Favorites menu and select Organize Favorites. 
   2. The Organize Favorites window will let you create folders and place bookmarks in 
those folders by using the New Folder and Move buttons. You can delete and rename 
existing bookmarks by using the Delete and Rename buttons. Dragging bookmarks 
around within the display window will change the order in which they appear. 
   3. Click Close to save your changes. 
 
Note: In the Favorites menu itself you may also drag bookmarks around to change the 
order in which they appear or to move them into folders. 
 
To import bookmarks (favorites) into Internet Explorer 7 
 
First, you must have your bookmarks exported from your old web browser. In most 
browsers, this is done by saving all your bookmarks into a file (you can name it whatever 
you want, but it is usually called bookmarks.html). Detailed instructions for backing up 
your bookmarks are available for specific browsers such as Netscape, Safari, Firefox, 
and older versions of Internet Explorer. 
 
After you have created a bookmarks file, do the following: 
 
   1. In Internet Explorer, click the Add to Favorites button Add favorites, and then click 
Import and Export. 
   2. The Import/Export Wizard will open up. Click Next. 
   3. Under Choose an action to perform, select Import Favorites. Click Next. 
   4. Under Import from a File or Address, select Browse. 
   5. Find and select your bookmarks file (e.g. bookmarks.html) and then click Next. 
   6. Select the folder where you would like to place the imported favorites. Click Next. 
   7. You have successfully imported your bookmarks. Click Finish. 
 
To export bookmarks (favorites) out of Internet Explorer 7 
 
   1. In Internet Explorer, click the Add to Favorites button Add favorites, and then click 
Import and Export. 
   2. In the Import/Export Wizard, click Next. 
   3. Under Choose an action to perform, select Export Favorites. Click Next. 
   4. Then select which folder you want to export. Clicking Favorites will export all your 
bookmarks. 
   5. Click on Browse to choose where you want to save your bookmarks, which will be in 
a file named bookmark.htm (you can also name it something else if you want). Click 
Next. 
   6. Click Finish. Click OK. 
   7. To import your bookmarks into a different browser such as Firefox, Safari, or an 
older version of Internet Explorer, follow the directions on this webpage, under the 
heading, Restoring Bookmarks. 


